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Introduction

This chapter introduces the book and lays out how you can work with it. It also introduces SketchUp 
as a design tool and explores the various ways in which you can use this software for a wide range of 
professional (or personal) work.

Key Topics:

■ SketchUp’s capabilities and uses

■ Approaches for working with SketchUp

■ Versions of SketchUp and their peculiarities

■ SketchUp’s context within Trimble’s product family

■ Conventions used in this book

1.1  A Multitude of SketchUp Users
During my years of teaching SketchUp, creating SketchUp extensions, and 
interacting with a large number of SketchUp users, I have come across 
many highly proficient users of this software and have marveled at their 
amazing work. Students and professionals take easily to SketchUp, and, 
before long, most of them produce very detailed building models and 
professional-grade renderings, only to name a few results. Some of this 
exemplary work is featured in this chapter and elsewhere in this book.

I have also found that too many people don’t go beyond the core 
features of this software and believe that some of the advanced mod-
eling, high-quality photorealistic rendering, or digital fabrication must 
be done using other software. Very often, they painstakingly pick up 
that other application without realizing that what they wanted to do 
was possible with SketchUp all along.

Sometimes even advanced users of SketchUp fully master one aspect of the software (photorealistic 
rendering, for example) but are completely unaware of the power that SketchUp holds in other areas—
parametric components and Ruby scripting are good examples. As you will find out in this book, SketchUp 
is a very powerful design and 3D modeling tool that can be used for rough sketch-based designs as 
well as detailed, highly precise modeling tasks. Some of its core features—for example, SketchUp Pro’s 
extendibility with extensions (sometimes also called plugins)—give it flexibility that makes it useful for 
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a large variety of disciplines. The immense popularity of this software and the large number of high-
quality extensions that are currently available for SketchUp bears powerful witness to this.

This book is a resource for basic to intermediate users and helps them make the leap from simply 
creating “something” in SketchUp to using it as a powerful design tool. It also contains several advanced 
topics (such as photorealistic rendering, parametric components, building information modeling (BIM), 
digital fabrication, and Ruby scripting), and provides a clear learning path that takes the reader through 
easy-to-follow exercises to a thorough understanding of the core topics. As an example of what can be 
achieved using the principles learned in this book, Figure 1.1 shows how one could use extensions to 
model curved beams and various architectural elements, employ Ruby scripting for patterned shading 
devices, and then render the scene using photorealistic rendering software. A sketched-style overlay 
and small details, all added in Photoshop, then finally “dress up” the image for presentation.

1.2  How Does SketchUp Fit into the Designer’s Toolbox?
As a professional or student, you likely already have assembled a sizable software “tool chest” by now. 
Depending on your discipline, this might include various office software, other CAD (computer-aided 
design) software, image-editing software, print layout software, analysis software (for energy or struc-
tural analysis, for example), construction coordination tools, and many others.

Figure 1.1:  Photorealistic rendering brings in reflections and better-quality materials, which can then still be combined with 
hand-sketched elements to add personality
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Figure 1.2:  Early-stage design concept illustration for a campus site. The designer used a SketchUp model to represent mass-
ing and shadows, which was then traced over in an iPad app (Procreate) to create a hand-sketched appearance. (Image courtesy 
of Omar Calderon, Perkins Eastman)

Figure 1.3:  Architectural design visualization model that was used to evaluate various shading solutions for an academic 
building. (Image used with permission of Leers Weinzapfel Associates)
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SketchUp fits into this collection very well. One approach is to use it as an early-stage design 
tool—after all, as its name indicates, it was developed for 3D sketching. In that capacity, it shines by 
providing easy editing and immediate 3D visualization (see Figures 1.2 and 1.3)—something that can 
be very useful during quick design iterations and discussions with clients. Materials can be applied in 
the software, which provides realistic visualization capabilities right in the 3D modeling environment. 
Shadows can also be displayed, which makes evaluation of overhangs, shading devices, and window 
recesses, for example, very intuitive.

You can also use SketchUp for the complete design process from initial stages to a finished prod-
uct (whatever that may be—buildings, landscapes, gadgets, etc.) (Figure 1.4). For that approach, 
it provides the capability to create precise, organized models that can contain any amount of data. 
Those models can then be used as the basis for construction or production documents (created e.g. 

Figure 1.4:  Detailed SketchUp model and photo of constructed residence. This project used a BIM extension, RubySketch, 
which is parametric and can create detailed building models that can even include a complete framing layout. (Image Courtesy 
of RubySketch © / Photo by Andrew Dwight)
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with SketchUp Pro’s LayOut software) and/or be exported for digital-process-based fabrication, such 
as CNC milling of parts.

The ability to visualize something in 3D is useful not only for a finished product but also for the 
process of making it. A good example is a construction site where material storage and handling, equip-
ment locations and capacities, and safety considerations often need to coexist in a very limited space 
(Figure 1.5). This can be laid out and evaluated completely in 3D in SketchUp, which often simplifies 
stakeholder feedback.

Other analytical uses of SketchUp can include scientific or analytical data in the model (e.g., infra-
red thermography images as shown in Figure 1.6, or daylight-intensity data) and visualize those in a 
3D-environment, such as by augmenting a correctly sized building model. Such models can then be 
annotated and shared as images, or entire models can be shared using 3D viewers that can be embed-
ded on websites and become interactive for the user to be explored using their mouse or a virtual 
reality (VR) headset.

SketchUp also works well with other software: 3D models from SketchUp can often be opened 
directly in those programs, making data exchange easy. Even where that isn’t available, SketchUp’s built-in 
file exchange options allow you to export a 3D model in a variety of formats. As shown in Figure 1.7, 
built-in services and bespoke extensions exist that connect SketchUp to online collaboration platforms, 
where you can share your models with only a few clicks.

Figure 1.5:  Construction site layout that includes the building’s structural frame, construction equipment, and the site fenc-
ing. The turning radius of the large crane and the siting of pickup and drop-off locations can be considered in such a model. 
(Image Courtesy of RubySketch ©)
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If SketchUp is already part of your toolset, then the best use of your time will be to expand on the 
skills you have already developed and deepen your knowledge of this software. This book provides you 
many avenues to do so.

Figure 1.6:  Thermal infrared house model made in SketchUp (top) and physically built as a paper model using extensions 
(bottom). For this project, images from a thermal infrared camera were pasted as textures to all surfaces using SketchUp’s tex-
ture positioning tools
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1.3  Easy 3D for Everyone
Because SketchUp is not domain-specific, it has found a following with 
professionals and enthusiasts from many disciplines. This is why you 
will find SketchUp used on projects not only by architects, landscape 
architects, urban planners, engineers, construction professionals, 
woodworkers, and timber framers but also by robot builders, artists, 
sculptors, model-plane builders, mapmakers, historians, 3D game 
developers, and movie set designers (just to mention a few).

Figure 1.8 shows how SketchUp was used for the set design of 
a recent movie. Luke Whitelock, the designer, created the entire set 
virtually in 3D so that not only construction details could be resolved, 
but also camera perspectives could be pre-visualized. SketchUp’s abil-
ity to save several camera positions, adjust the field-of-view for each, 
and then document everything in LayOut makes this process easy.

The techniques in this book are applicable to a variety of disciplines. Although many examples come 
from architecture or construction, some are from other, related disciplines (e.g., landscape design or 
interior design). Whatever your background is, feel free to take the examples that are presented here 
and adapt them to your work. The skills you acquire will be equally useful.

Taking this one step further, I can even say that I can’t think of anyone who should not be using 
SketchUp. Living in a three-dimensional world and dealing with three-dimensional objects, everyone 
has the need at some point to model and visualize virtually in three-dimensional space.

Consider these hypothetical (but very common) situations: A homeowner wants to build a deck in 
their backyard and needs to explain to the builder how it should look. Another example is a scientist 

Figure 1.7:  Trimble’s 3D Warehouse website is one example of an online repository where users can share and acquire 3D 
models, including many commercially available products
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Figure 1.8:  Several views of a movie set design with camera previsualization created in SketchUp and presented using LayOut 
(top), and the completed set as built (bottom) (Images courtesy of Luke Whitelock)
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who needs to illustrate a lab setup for a presentation. Far too often, we resort to 2D representations of 
our thoughts (the classic floor plan, for example), which leave too much unknown and unexplorable. 
3D views are intuitive, are easy to understand, and make it simpler to discover issues and fix problems.

Admittedly, many people are not trained in hand-sketching in 3D, which often leads to poor visualiza-
tions of things that can actually be quite interesting when presented properly. That is where SketchUp 
shines. Its 3D modeling capabilities and its ease of use make it a simple yet very powerful tool for anyone 
to give shape to their thoughts.

1.4  Windows or Mac, Pro or App, iPad or Phone?
SketchUp now comes in a multitude of flavors: Desktop-based SketchUp Pro has always been the core 
commercial product and is available for both Windows and Mac computers. A few years ago, Trimble 
started to develop adapted versions on other platforms, too. First was a web-based version (available at 
the URL app.sketchup.com), which can run in any browser on any operating system (even on Linux-
based machines, which had been a longtime user request). It replicates most of SketchUp Pro’s core 
functionality, with the most important difference being that the user cannot install extensions in it.

Most recently, Trimble also produced a version of SketchUp that runs on the iPad (Figure 1.9) and 
makes full use of Apple’s stylus, which allows for an even more intuitive workflow than the desktop 
version already had. Add to those SketchUp’s viewer applications for computers (on both platforms), 
as well as iOS and Android phones and tablets, and an augmented reality (AR, sometimes also called 

Figure 1.9:  SketchUp’s iPad app works with Apple’s stylus
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extended reality—XR) edition that works with Microsoft’s Hololens. With this breadth of products, 
Trimble has expressed its ongoing commitment to a free version, which was in the past a scaled-down 
desktop program (called Make, discontinued in 2017), but now it is a feature-limited edition of the 
browser-based app.

Like most other software manufacturers, Trimble now uses a subscription model for its software. This 
means, that depending on the needs of the user, one of several tiered plans can be bought, which all 
come with an annual fee (instead of a one-time cost for a perpetual license, as was common in the past). 
The most basic plan is the “Free” version, which gives access to the web app, mobile viewer, and Trimble 
Connect (more on this service in the next section). The most comprehensive “Studio” plan currently offers 
access to all the features of the mobile and desktop apps (including the ability to use extensions), LayOut 
(SketchUp’s drawing creation software), the iPad app, AR/XR viewers, and includes access to point cloud 
and rendering software as well as several other tools and features. As a result, hobbyists, makers, and 
private 3D modelers will likely start off with the free version and may subscribe to one of the lower tier 
plans as their needs increase. Design professionals will likely be enticed by the full-featured upper-tier plans.

Qualified students can get access to individual licenses of SketchUp at a significantly reduced annual 
cost and universities will likely want to procure entire computer lab packages. And primary/secondary 
students often have access to the free “SketchUp for Schools” program, which is based on the web 
app. You can find out more about these plans and see current costs on SketchUp’s website: sketchup 
.com/plans-and-pricing.

All versions are currently available in a multitude of languages, and even though the software is 
produced in the United States, it very capably handles metric units as well, which gives this software 
global reach. When comparing the various versions of SketchUp (and the subscription plans), it may be 
useful to base your evaluation on the following feature differences:

■■ LayOut comes only with the desktop version, SketchUp Pro. It can replace other drawing- and 
presentation-creation software, enabling you to keep that aspect of your workflow tightly aligned 
with SketchUp. 3D models created in SketchUp are always live-linked to LayOut so that updates 
propagate through the entire drawing set.

■■ Style Builder is a small software that only comes with SketchUp Pro and allows you to create custom 
sketchy lines.

■■ File import/export is limited in the free version. Make sure the version you subscribe to has the capa-
bility you need, e.g., DWG/DXF for CAD import/export, PDF creation, EPS for line art, and various 
3D file formats: DAE, 3DS, FBX, OBJ, XSI, VRML. For file exchange with BIM software, make sure IFC 
is available. Fortunate for hobbyists that use 3D printers, STL is already available in the free version.

■■ Solid Tools, which are great for Boolean-based solid-type modeling (add, subtract, trim . . .) are not 
available in the free version.

■■ Some of the data-exchange and advanced authoring tools are also typically limited on lower tiers, 
such as image/video export, component-based report generation, Dynamic (and Live) Component 
authoring, or point-cloud modeling. The latter is also limited to Windows.

SketchUp uses the same SKP file format for all of its applications. This means that you can work on 
the same file and move it back and forth (e.g., between SketchUp Pro and the web version without 
any loss of fidelity). This is useful if a particular tool is only available in only one of these (e.g., video 
export, extensions, or the ability to use a stylus).

TIP
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Many of the more advanced features allow the professional SketchUp user to integrate it into their 
workflow by making it easier to exchange data with CAD software (such as Autodesk AutoCAD), BIM 
software (like Autodesk Revit), online collaboration platforms (like Trimble Connect), and presentation 
software (like Adobe Illustrator). Modeling and workflow enhancements (such as the ability to create 
Dynamic or Live Components) also provide the professional user with the capability to create and dis-
seminate product-model databases that facilitate planning and estimating tasks. The current iteration 
of the top-tier subscription even includes a license for V-Ray, a rendering software.

Depending on your needs, you have to decide which version is right for you. If you use SketchUp 
only for hobby projects or for basic training and you have no need for any of the advanced features, then 
the free web-based version should suffice. This book then offers a cost-efficient entry into relevant and 
current topics (such as 3D modeling, rendering, and digital fabrication). Note, however, that this book’s 
chapters on extensions, rendering (where extension-based rendering software is used), computational 
geometry, and LayOut will not be applicable to you. If you, however, need and want to learn about the 
more advanced features and are planning on using SketchUp professionally, then your best approach is 
to get the Pro version right away. In that case, the entirety of this book will prove useful.

While this book’s illustrations have been created using the Windows version of SketchUp, the tasks 
and tutorials are similarly usable with the Mac version. Menus and dialogs generally look similar and are 
in a similar location on both platforms. There are minor user-interface differences, but they are easy to 
figure out. Consult SketchUp’s help system if you run into trouble.

1.5  Trimble’s Product Ecosystem
Trimble Inc. is a technology company that was founded in 1978 and is headquartered in Colorado. Its 
product range combines software applications with (mainly surveying) hardware in every field it engages 
in. While it has a large division that centers on the built environment, its products are likewise used 
in agriculture, transportation, utilities, and many other fields. Professionals in the AEC (architecture, 
engineering, and construction) area may know Trimble from using its surveying hardware (optical- or 
satellite-based) on construction sites (Figure 1.10). Or they may have worked with its Tekla software for 
building planning and steel/concrete fabrication. Trimble also provides solutions for estimating, project 
delivery, and facilities management.

When Trimble acquired SketchUp in 2012 from Google, it added a crucial piece to its already quite 
large array of tools. SketchUp’s ease of use and extendibility makes it ideal for field-based solutions, 
design concept development, visualization, and web-based collaboration. Since that time, Trimble has 
integrated SketchUp into many of its work areas and is actively pursuing a broadening of its software 
offerings (Figure 1.11). Case in point being the 2014 acquisition of Gehry Technologies and its software, 
which now lives on as Trimble Connect.

Because of this close integration with other Trimble services and products, SketchUp can be used 
in the following applications:

■■ Collaboration and data exchange. The Trimble Connect web-based platform serves as the central 
data hub between many Trimble products (Figure 1.12). A direct file upload/download connection 
is now built into many Trimble software products (including all versions of SketchUp) and can be 
added to others (e.g., Autodesk Revit by installing an add-on). At this point, everyone who signs 
up for a Trimble account (even if only to use SketchUp Free) even gets 10 GB of online file storage 
in this service, which makes this one of the more generous file storage platforms available. Trimble 
Connect goes beyond file storage and exchange, though, by providing markup, versioning, and 
workflow assignment tools as well as an online 3D viewer for various file formats, which can even 
perform basic clash detection tasks.
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■■ Laser scanning and point cloud modeling. Trimble makes a range of scanners (e.g., the TX-8 or 
their scanning total station SX-10) whose point clouds can be processed in their Realworks software 
and then used in SketchUp Pro for 3D modeling with the Scan Essentials extension. See Chapter 3 
for an example of this workflow.

■■ Surveying. Trimble’s total stations (e.g., the robotic S9) or its GNSS (global navigation satellite 
system) satellite-based tools (like the R12) can be used to survey (or lay out) points on a variety of 
terrains. That data can then be processed in Trimble’s Business Center software for further use, 
such as in SketchUp.

■■ Building performance analysis. In 2016, Trimble acquired Sefaira, a software that allows for 
real-time building performance analysis and daylight assessment. It integrates into SketchUp Pro 

Figure 1.10:  Trimble’s R10 GNSS units in action during a workshop at the UMass Amherst Trimble Technology Lab

Figure 1.11:  SketchUp’s product family icons (left to right): SketchUp, LayOut, 3D Warehouse, Extension Warehouse, Pre-
Design, Style Builder
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Figure 1.12:  A SketchUp model is displayed and annotated (for review) in the Trimble Connect platform

Figure 1.13:  PreDesign provides site-contextual information such as urban context, climate, sun paths, and prevailing winds, 
and then suggests various architectural design responses to those

as an extension and is typically used in the earlier, conceptual design stages. Another product, 
PreDesign, comes with the SketchUp Pro plans and provides the planner with location-based early-
stage design data and recommendations (Figure 1.13). It is available at predesign.sketchup.com.

It is worth keeping an eye on developments in this area within Trimble because many new possibili-
ties may open up with enhanced integrations or new acquisitions. A good opportunity to do this is at 
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either one of Trimble’s two user conferences: SketchUp’s 3D Basecamp and Bootcamp conference (in 
alternating locations) or Trimble’s all-product Dimensions conference (held in Las Vegas, NV).

1.6  About This Book
Each chapter in this book presents a different SketchUp use in sufficient detail to get you started and 
working quickly. Interspersed with the text are many step-by-step examples, tips, and in-depth articles. 
At the end of each chapter, you will also find a collection of activities that you can undertake to practice 
new skills that you just learned.

Chapter 1, which you are reading now, introduces SketchUp and its applications and puts it into 
context within various common use cases as well as the broader product ecosystem that Trimble provides. 
The different versions of SketchUp and the current licensing models are discussed, too. This should give 
you all the information you need to decide which version (and subscription plan) is right for you and 
how you can get started with SketchUp.

Chapter 2, which follows this introductory chapter, brings every reader up to speed. Its purpose as 
a “SketchUp Refresher” is to review most of the basic modeling techniques and teach good practices 
for 3D modeling and software use. While many readers will already have some knowledge of SketchUp 
through introductory books or video tutorials, this chapter encompasses enough variety to be useful 
for everyone, independent of their skill level. In addition to 3D modeling, this chapter covers materials, 
program setup, and user interface, as well as creating a custom template.

Chapter 3 provides a thorough overview of the many ways SketchUp can be used. Geo-based modeling, 
plan-based modeling, and point-cloud modeling is covered. In addition, this chapter introduces SketchUp 
as a tool that can inform your designs by adding data and design intelligence to your models. Examples 
of this are creating hierarchical, component-based models (e.g., for virtual construction), using Dynamic 
and Live Components, and parametric design, as well as working with SketchUp’s Classifier system. This 
chapter also lays out how SketchUp can fit into a BIM-based architectural design process (Figure 1.14).

Chapter 4 guides you through the wide field of SketchUp extensions and their uses. After an intro-
ductory section on finding and installing extensions, many individual extensions are discussed. Those 
small (or sometimes large) software add-ons to SketchUp provide tools for general modeling, such as 
drawing splines and lofting curves; tools for architectural design, such as stair making and wood fram-
ing; and tools for digital fabrication that will help you prepare your model for 2D and 3D digital printing 
and assembly. (See Figures 1.6 and 1.18 for examples of fabricated SketchUp models.) Furthermore, 
there are extensions for data integration that allow you to work with file types that SketchUp does 
not natively support; extensions for animation and presentation that add object animation or serve as 
helpers for creating animations and walk-throughs using SketchUp; and, finally, extensions for analysis, 
which provide interpretive tools—mainly from the field of building energy analysis and green building.

Chapter 5 introduces photorealistic rendering and covers all aspects of rendering in detail (see 
Figure 1.15 and Figure 1.16). This chapter was written to be as independent of your actual choice of 
rendering software as possible, thereby providing a useful resource no matter which software you end 
up getting. As part of this chapter, you will learn about modeling for rendering, lighting, sky environ-
ment, materials, and objects, as well as how to edit and modify renderings for final presentation using 
image-editing software.

Chapter 6 lays out how SketchUp can be used for digital fabrication. While SketchUp has always been 
used to fabricate buildings, this is typically accomplished with a manual process (employing workers) 
and analog intermediaries (printed construction documents). Digital fabrication (as employed in fabrica-
tion preparation, 3D printing, laser cutting, CNC milling, etc.) uses the full precision that the computer 
provides from concept to final product. This approach offers many new and exciting possibilities (see 
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Figure 1.14:  A design visualization created in SketchUp and rendered with Lumion (Image courtesy of Omar Calderon, 
Perkins Eastman)

Figure 1.15:  A night rendering (using the Twilight renderer) of the building from Figure 1.1

Schreyer161133_c01.indd   15 5/5/2023   12:34:01 PM



Architectural Design with SketchUp

16

Figures 1.17 and 1.18 for some examples), and this chapter provides you with step-by-step instructions 
on how to use these techniques with SketchUp.

The penultimate chapter in this book (Chapter 7) introduces you to the exciting field of computa-
tional geometry in SketchUp. This chapter presents Ruby script examples that create undulating brick 
walls, solar-responsive facades, attractor-based colorful building designs, and other fun ways to create 

Figure 1.16:  A landscape modeled in SketchUp and rendered in Enscape

Figure 1.17:  SketchUp’s CNC-fabricated WikiHouse pavilion for the 2013 New York Maker Faire (Used by permission of 
Trimble Navigation Ltd.)
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geometry in SketchUp without excessive use of the mouse (see the façade panels in Figure 1.1 for an 
example). Most of the script examples accomplish their tasks in just a few lines of code, and all are good 
introductions to both the Ruby scripting language and the general field of computational geometry.

Chapter 7 can also serve as a “learn to code” curriculum for young or adult readers. It introduces 
basic programming concepts and applies them in a way that yields 3D models. It should be quite excit-
ing for the learner that the results from this approach can even be 3D printed and, therefore, turned 
into physical objects.

Chapter 8, which is new to this edition, covers SketchUp Pro’s LayOut software (Figure 1.19). Where 
SketchUp is used for creating in 3D, LayOut is used for presenting those creations elegantly in 2D. This 
software, which installs with the desktop versions of SketchUp Pro, allows you to arrange views of a 
SketchUp model on sheets and then annotate those with standard documentation items like leader 
text, dimensions, tables, and other elements. LayOut is a full-fledged presentation software that can 
be used to create page layouts and then present those on a screen or export them to PDF format. Its 
other features like scaled drawing and CAD import/export will also be covered in this chapter.

As you will see in the chapters that follow, this book is intended to serve as a textbook as well as a 
desk reference. It was written to convey the presented material in a thorough yet easy-to-follow manner. 
It also covers common tasks using a cookbook approach, which allows you to simply copy the procedure 
to get a satisfactory result or modify it according to your individual needs.

In addition to reading this book, keep an eye on its companion website, which features news, tutori-
als, links, videos, and downloads related to this book. You can also interact there with the author and 
discuss any issues you may run into. Web links will be frequently updated there, and new ones added as 

Figure 1.18:  Three items designed by my students in SketchUp and then 3D printed
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new software is released. It is also a good idea to stay up to date with SketchUp’s own news. Therefore, 
bookmark the following sites to help you with this:

1.7  How This Book Works
One way to use this book is linearly as a learning tool by moving from chapter to chapter. This method 
builds your skill set gradually and allows you to logically approach each subject. You may also want to 
use it as a desk reference, or you might be interested only in individual chapters. In those cases, make 
use of the index and the appendices as needed.

Following are some conventions used in this book. By default, they are based on the Windows version 
of SketchUp Pro, but Mac- and App-specific differences are mentioned as well where they are relevant:

■■ Whenever I mention a panel (e.g., the Materials panel), this means the dockable window that is 
located in a tray (a collection of collapsible panels) on the right side of SketchUp Pro’s application 
screen. If a panel is not shown, then you can display it via the Window menu. You can even create 
several, customized trays that way. On the web and iPad apps, those panels are hardwired to icons 
on the right side of the screen and cannot be customized.

sketchup.com—The official home of SketchUp. You can get the latest version here and read the 
latest news from Trimble.

blog.sketchup.com—The official SketchUp blog—a great source for news, user stories, tutori-
als, and tips.

sketchupfordesign.com—My companion website for this book, which has downloadable 
content, many tutorials, and SketchUp news.

wiley.com/go/adsu3e—Wiley’s companion site for classroom use.

alexschreyer.net—My personal site where I frequently post about SketchUp, other AEC soft-
ware, and various construction topics.

@sketchup4design and @alexschreyer—My Twitter handles under which I post news and 
links about SketchUp and AEC software.
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■■ Windows that open on top of the application are commonly called dialogs in the text. The Add 
Location feature is a good example for this.

■■ Menu locations are typically presented in this format: File → Open. . .. Note that the web app 
has less menu options than the desktop version, which means that most tools need to be accessed 
otherwise (keyboard shortcuts, tool icons, or SketchUp’s search feature).

■■ Whenever a tool from the context (right-click) menu is mentioned, make sure that you position the 
mouse cursor exactly above the object of interest to get the menu options that relate to this object’s 
context when you right-click.

■■ Any toolbars mentioned in the text can be opened from the View → Toolbars. . . menu in SketchUp 
(or by right-clicking on any open toolbar). Extensions often install their own toolbars. Those will, of 
course, not be available until an extension has been installed or reactivated. Toolbars can be closed 
and reopened at any time. In the web and iPad apps, only some toolbars float and dock; most slide 
out when a tool category at the left side of the screen is selected.

■■ Where applicable, examples in this book use US-customary construction units such as the inch (") 
or foot ('). If you don’t use these units, read the “Setting Units and Fonts” section in Chapter 2 and 
adjust the use of units in the examples to your unit system. SketchUp works well with any unit system.

■■ If you are using a Mac, you will notice these differences:

■■ Keyboard shortcut combinations use the Command key rather than the Ctrl (control) key.

■■ SketchUp’s preferences cannot be found under the Window menu item, but instead are under 
the SketchUp menu.

■■ Toolbars are called tool palettes.

■■ Instead of right-clicking to bring up the context menu, you can left-click the mouse while hold-
ing the Control key.

Let’s Go!
It’s time to explore the world in the third dimension. Enjoy your modeling endeavors!

Schreyer161133_c01.indd   20 5/5/2023   12:34:04 PM


